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INTRODUCTION
The Pedestrian Area Lighting software (Plepal) produces Spacing Tables which can be used as
design aids in lighting of Category ‘P’ roads in Australia and New Zealand. Category ‘P’ was
introduced in the revised Road Lighting Code AS/NZS 1158.3.1:1999, released in November 1999.
This Code supercedes [in part] the AS1158.1:1986 and NZS 6701:1983 Codes. The Pedestrian
Area Lighting software also supports several other elements referred to in the Code.
It is assumed that the user has basic knowledge of the operations of the PC and the Windows
95/98/NT/2000/XP operating system.
Before reading any further, briefly look through this manual and you will notice that screen
snapshots have been used quite regularly. This has been done to make it easier for you to equate
the manual with the operation of the software. The example used in the snapshots utilizes the
sample photometric data supplied in the file named Testfile.cie.

2.

INSTALLING THE SOFTWARE
The software is provided in either of two forms depending on how it was purchased (i.e. either as a
stand alone version or as part of the main Perfect Lite software package). In either case the
Pedestrian Area Lighting software will be contained on a CD ROM and will require the following
procedure to install the software correctly.
First load the CD ROM into your CD Drive and click on the Start button, Select Run… from the
menu and type x:\Plepal\setup.exe (x: is the drive letter of your CD) into the Run dialog box and
then click OK.

Follow the subsequent instructions on the screen to correctly install the Pedestrian Area Lighting
software on your computer. Generally, it will only be necessary to click on the Next button several
times to carry out the installation.
It is recommended you choose the default folder (c:\Program Files\Perfect Lite) in which to install
the software. If you install it in another drive and/or folder then please make a note of the location
below for future updates.
Pedestrian Area Lighting software installed in: …………………………………………………………..

3.

REMOVING THE SOFTWARE
Should the need arise you can uninstall the Pedestrian Area Lighting software by using the
following procedure. Please note that it will only remove the components that were originally
installed from the installation diskettes. The folder where the program is located will remain with
any files that you may have subsequently created or copied into the folder.
First click on the Start button, select Settings and then Control Panel from the fly out menu.

© Copyright Trevor Caswell 1999 - 2004

Page 2

Perfect Lite - Pedestrian Area Lighting to AS/NZS 1158.3.1:1999

Version 2.06

Then double click on the Add/Remove Programs icon.

On the Add/Remove Programs Properties window scroll down to and highlight the Perfect Lite –
Pedestrian Area Lighting item and click on the Add/Remove… button.
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Then click on the Yes button on the Confirm File Deletion message box.

The various components of the software will then be removed and the screen as below will be
display the progress. When complete click on the OK button.

Next click on the Cancel button on the Add/Remove Programs Properties window and then
close down the Control Panel group of icons.
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STARTING THE SOFTWARE
Click on the Start button and select Programs then Perfect Lite then Pedestrian Area Lighting.

The window as shown below should be displayed from where you can continue to operate the
software. If you are unfamiliar with the software then it is suggested that you undertake the ‘brief
tour of the software’ as described in the following section.
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BRIEF TOUR OF THE SOFTWARE
Before you produce a Spacing Table (or do anything else in the software) it is necessary to open
up (or load) a photometric I-table. These I-tables would be stored on your computer or on a floppy
diskette as a file supplied from a manufacturer or supplier. To get you up and running the software
is supplied with a sample file (Testfile.cie) which corresponds to the one used in Appendix E of
AS/NZS 1158.3.1. From the File menu click on Open I-Table.

This will then display the screen where a further input is required.

Each time you enter this screen (and most others in the program) the fields will be filled with the
data last input. Should you wish to select a different file then either type the name directly into the
I-Table File Name field, click on the combo box to select previous files or click on the Browse
button to invoke the standard Windows File Open Dialog Box to select an appropriate file.

© Copyright Trevor Caswell 1999 - 2004

Page 6

Perfect Lite - Pedestrian Area Lighting to AS/NZS 1158.3.1:1999

Version 2.06

It should be noted that by default the dialog box will initially only display files with a “cie“ file
extension. If this is not the type of file you are looking for make a choice from the Files of type
drop down list box. When the desired file is in the File name field click the Open button on the file
dialog box to continue on with the software.
When all the information has been entered click on the Next button to continue on with the
software. On the subsequent screen input descriptions of the luminaire being used, initial flux,
maintenance factor etc..

Inputs in the description fields are only necessary for identification of the luminaire/lamp and will be
included on any output produced by the software. Once again when all the information has been
entered click on the Next button.
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You have now loaded the file (I-table) into the software and at this point you can view the
photometric I-Table by selecting either of the top two items from the View menu.

But the main thing that we want to do is produce a Spacing Table. From the Spacing Table menu
select Local Roads… .

The screen will change to show several input fields to be filled with appropriate data relative to the
Table you wish to produce. As this is the first time the software has been run it will have the
default values as used in Appendix E of the AS/NZS 1158.3.1.

For this tutorial leave the fields as they are above.
Now might be a good time to talk about the On-line Help accessible in the software. If you are in
doubt as to what details should be input into any field then simply put the cursor in that field (i.e.
Left mouse click on the field) and press the F1 key. A pop-up Help screen will appear giving you
information on the contents of the field and limiting values that can be input. This help feature is
© Copyright Trevor Caswell 1999 - 2004

Page 8

Perfect Lite - Pedestrian Area Lighting to AS/NZS 1158.3.1:1999

Version 2.06

available for any item on the Menu, any button or screen displayed. To remove the Help screen
click on the X in top right-hand corner of the screen.
Now, press the Next button to get the software to carry out the necessary calculations to determine
the maximum spacing for the range of road widths and heights etc. selected. An example of the
top part of the Table then displayed on the screen is shown below.

Use the scroll bar on the right side of the screen to move the display up to view more of the Table.

To print out the complete Table on your printer click on the Print button and the standard Windows
print dialog box will be displayed.
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Select the appropriate printer and click on the Ok button to produce the printout.
Once the printout has been produced click on the Close button to remove the calculated results
and return to the screen where you can change some or all of the values and produce another
Table. If you don’t want to produce another Table then click on the Back button. This will take you
back to the point in the software where you can make another selection from the Main menu along
the top of the window.
To close down the program altogether select from the File menu the Exit option or click on the X in
the top right-hand corner of the software window.

The remainder of the choices from the Main menu are self explanatory so I won’t go into details of
what they are about. If you have doubts then place the cursor over the required menu item and
while holding down the left mouse button press the F1 key and a pop-up Help screen will be
displayed (eg. For the Miscellaneous menu see next page).
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UPDATE HISTORY
The following is a brief list of all the major changes that have taken place over the years in the
Pedestrian Area Lighting software (and prior to 1999 the Spacing Graph Generator software).

PEDESTRIAN AREA LIGHTING (PLEPAL)
VERSION – 2.06 (Released June 2004)
• “Multi File Mode” added which allows the automatic processing of up to 200 I-table files
against a single set of layout parameters.
• Due to access problems associated with Network security the configuration files (Plepaluser.cfg) is now stored in the same folder as the program (NOT root folder of C drive).
• Warning message is given if the Printer used for output is changed from the default
printer.
• Program version/Date stamp on bottom of printouts has been modified slightly.
• Contact email address on ‘About’ screen changed.
VERSION – 2.05 (Released May 2003)
• Released with Perfect Lite - Version 4.86a
• ‘Save As…’ button added to the screen where all results are viewed. This allows you to
save or append the results to a text file rather than printing them out.
• Progress bar added to the Local Road and Pathways calculation screen.
• Allows Category P1 & P2 for Local road calculations (ignores Vertical illuminance).
• Now validates the Company name against the serial no. of the software.
• Contact details changed on the ‘About’ screen
• Calculation of Luminaire Classification corrected.
• Note about compliance after ‘5 November 2001’ removed as no longer applicable.
VERSION – 2.04 (Released May 2001)
• Released with Perfect Lite - Version 4.84
• When ‘tabbing’ between input fields the whole field is highlighted so if you want to
change the whole field you simply start typing the new value rather than first erasing all
previous text. If you want to just change part of the field then press the <End> key and
the highlight will disappear and you can move the cursor back to what you want to
change data.
• Initialisation file (“.ini”) now referred to as a Configuration file (“.cfg”)
VERSION – 2.03b (Released October 2000)
• For Local Roads and an Opposite arrangement the program now allows the luminaire
Offset to exceed half the Road Reserve width - this will simulate a Central arrangement.
VERSION – 2.03a (Released August 2000)
• The bug has been fixed where the program could not be re-started and restored to full
size if closed down (or the PC shutdown) when it is minimised.
VERSION – 2.03 (Released May 2000)
• A field description on the Path Spacing Table input screen has been changed from
‘Distance from Path Edge’ to ‘Offset from Path Edge’ to remove confusion as to what the
distance represents – see associated help screen.
• ‘&’ character can be used in ‘Offset Distance’ and ‘Offset from Path Edge’ field to
nominate the luminaire position as halfway across road reserve or path. Compliments
the ‘*’ character for one quarter across road reserve/path already built into the software.
• A history of revisions to the software added to the Contents item on the Help menu.
• When selecting ‘Open an I-table’ from the menu, the ‘I-Table File Name’ field has been
changed to a drop down list box allowing the selection of the file name from one
previously used
VERSION – 2.02 (Released February 2000)
• When selecting ‘Open an I-table’ from the menu, the first input screen has been changed
to only select the required file name. On the subsequent screen where you would
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normally input the description you now also input the flux, maintenance factor and upcast
angle.
Save the values entered for ‘Luminaire Description’, ‘Lamp Wattage and Type’ and
‘Stores Code’ against the file name so it will be automatically displayed next time the
same luminaire is used.
Check box added to allow all the LTP’s at maximum spacings to be displayed on a
separate page of the Spacing Table.
Check box added to allow all the display of illuminance values at grid points of each
maximum on separate pages of the Spacing Table.
The location of the PLEPAL program window on the display screen will now be restored
to where it was located last time the program closed down.
Luminaire Classification changed to show if it complies after 5 November 2001.
A ‘Back’ button has been added to some screens & position of the ‘Next’ and ‘Back’
buttons swapped around on other screens.

VERSION – 2.00 (Released November 1999)
• Released as a result of the revision to the Australian and New Zealand Public Lighting
code AS/NZS 1158.3.1:1999 where lighting category ‘P’ was introduced.
• The program has been converted to a true 32 bit Windows Application and the named
changed to Perfect Lite – Pedestrian Area Lighting (PLEPAL.EXE). The previous MSDOS versions (1.60, 1.59 etc.) was known as the Spacing Graph Generator for Minor
Roads (PLESPACE.EXE).

SPACING GRAPH GENERATOR (PLESPACE)
VERSION - 1.63 (Released May 2001)
•
•
•
•

Released with Perfect Lite Version 4.84
Modified to do all printing through the Windows Print Manager
Menu added at start of program to select printer for output
With the introduction of AS/NZS 1158.3.1 this program has effectively been superseded
by the Pedestrian Area Lighting software (PLEPAL) – refer separate manual detailing this
software.

VERSION - 1.60 (Released June 1998)
• Released with Perfect Lite Version 4.82
• Allows the specification of a full Path for an I-Table file
• Standard DOS file dialogue used for file selection
• For Mode 3 – A maintenance factor of up to 10 can be used for R-Table ‘0’ to calculate
Lux rather than Cd/m2
VERSION - 1.59 (Released April 1997)
• Released with Perfect Lite Version 4.81
• Road Width changed to go from 2m through to 40m
• Now uses version 1.60 of PPD.EXE for printer output
VERSION - 1.58
• Special issue for SEQEB/Energex in Queensland
• Rounding off of displayed results corrected
• 'Count' column removed
• 'Plot' & 'Redraw' option removed from graphics screen
• Error message given if 'PPD.EXE' file not found prior to printing
• Printer port displayed after printer description on opening screen
• Spacing range increased to 120m on graph/plot
• Road reserve width increased to 38m on graph/plot
• Default Upcast angle set to 5 degrees
• Reading default set up values from file ‘PLESPACE.TBL’ added
• Reading from file PLESPACE.LIN now fully supported
• Maximum spacing displayed to 1 decimal place
• 'Emax/Eav' displayed to 1 decimal place
• 'NO COMPLIANCE' added if Maximum spacing less than 0.005m
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• <F5> key added to select from Parameter table file
• If PLE.HLP not found then PLESPACE.HLP used
VERSION - 1.57 (Released July 1995)
• Message window displayed if 0 cd/m2 found at V=0 in I-table - "/ADJ" command line
option added to adjust values to 1 cd/m2
• "DESCRIPTION=" line added to 'PLESPACE.INI' file
• Disables MOUSE if file 'MOUSE.NO' found
VERSION - 1.56
• Text 'AS1158.1 -1986' added
• Display/Print out fixed so when NOT complying spacing 'Eav','Emin','Emax/Eav' shows
last actual calculated values NOT last "complying" values
• Version no. added to text results screen/print out
VERSION - 1.55
• Now uses version 1.42 of PPD.EXE
• <Esc> used to abort processing of PrintGL print out
• Colour argument of 'PSET' & 'LINE' made Long Integer
• Configuration file now "PLE48.INI"
VERSION - 1.54
• Draws vertical ordinate at nominated values as in file "PLESPACE.LIN"
• Rounding off corrected to be same as print out
VERSION - 1.53
• ‘Opposite’ arrangement re-instated as maximum now determined using both lights
VERSION - 1.52
• '/FULL' command line option added for detailed calculation output to file
• Now support large asymmetrical I-table files
• Problem fixed in calculating Eh behind light
• ‘Opposite’ arrangement removed till Finding maximum is done properly
• Undocumented '/GRID' command line option added
VERSION - 1.51
• Uses PLE.HLP as the Help file
• Will use Hercules Graphics card
• Stand alone version displays colours in Help correctly
VERSION - 1.5
• Use PPD.EXE instead of PRINTGL
• Can be called from PLE.EXE (PLESPACE.INI automatically set up)
• Released with version 4.77 of Perfect Lite
• PPD.EXE outputs to DOS LPT? not BIOS LPT? (fixes bug with network printers)
• Uses PLE47.INI for configuration options
VERSION - 1.4
• NON Intel co-processor problem fixed
VERSION - 1.3
• Program corrected for when no solution found for a particular road width
• Thickness added to printer output
VERSION - 1.2
• PRINTGL used for graphics printer output
VERSION - 1.1
• Minor changes only
VERSION - 1.0 (Released 1990)
• Original issue
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